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Copyright Notice
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any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
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this Epson printer. Epson is not responsible for any use of this information as applied to other printers.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for 
damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of 
this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to 
strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or 
any consumable products other than those designated as Original Epson Products or Epson Approved Products by 
Seiko Epson Corporation.

A Note Concerning the Responsible Use of Copyrighted Materials
Digital cameras and scanners, like photocopiers, conventional cameras, and ink jet printers, can be misused by 
improper copying and reprinting of copyrighted material. While some countries’ laws permit limited copying of 
copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. 
Epson encourages each user to be responsible and respectful of the copyright laws when using digital cameras, 
scanners, and ink jet printers. 

Trademarks
Epson, Epson Stylus, Epson Photo Stickers, and MicroWeave are registered trademarks and PRINT Image 
Matching and the PRINT Image Matching logo are trademarks of Seiko Epson Corporation. 

RPM and ColorLife are registered trademarks; Resolution Performance Management, Epson Software, 
PhotoEnhance, BorderFree, and PremiereArt are trademarks; and Epson Print Lab, Epson Store, SoundAdvice, 
and Epson Connection are service marks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of 
their respective owners. Epson disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.
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Welcome!

Your Epson Stylus® Photo R320 can print pictures directly from your digital camera’s memory 
card. You can create true BorderFree™ photos directly from your printer in a variety of sizes 
just minutes after taking pictures with your digital camera. These photos are perfect for 
albums or framing or sharing with family and friends.

If you want to save your image files, you can transfer them immediately to your Windows® or 
Macintosh® computer and print from your PC. 

Here are some of the printer’s outstanding features:

■ Epson’s exclusive 6-color ink technology lets you achieve fine shadow detail, dazzling 
highlights, and excellent fill across a wide range of colors. Genuine Epson® ink and papers 
create long-lasting and water-resistant prints.

■ CD and DVD printing on ink jet-printable CDs and DVDs, with or without a 
computer. 

■ Ground-breaking Resolution Performance Management™ (RPM®) technology optimizes 
the number and placement of ink droplets on a variety of papers for superior photo 
quality and performance, with manageable print file sizes.

■ Three built-in memory card slots support CompactFlash™ Type I and II, Secure Digital, 
MultiMediaCard,™ xD Picture Card, SmartMedia,™ Sony® Memory Stick,® Memory Stick 
Pro,™ Memory Stick DUO,™ and IBM® Microdrive.™ 

■ An extra USB port on the front of the printer lets you connect a digital camera 
(supported models only) or an external storage device, such as an Iomega® Zip® drive or 
CD-R drive. This lets you save your memory card contents to a Zip disk or CD-R and 
access stored photos without a computer. (The port on the back of the printer is for 
connecting the printer to your computer.)

■ A preview monitor helps you select photos for printing.

■ Your printer also supports Bluetooth® technology (using an optional adapter) for sending 
prints wirelessly from Bluetooth-enabled phones, PDAs, etc. 
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About PRINT Image Matching

Your Epson Stylus Photo R320 includes support for Epson’s revolutionary 
PRINT Image Matching™ technology. PRINT Image Matching lets your 
digital camera and printer work together automatically to produce the best 
prints possible. Digital camera manufacturers that support PRINT Image Matching include 
Epson, Casio,® Contax, JVC,® Konica,® Kyocera,® Leica,® Minolta,® Nikon,® Olympus,® 
Panasonic,® Pentax,® Ricoh,® Sanyo,® Sony and Toshiba.® Check with your camera’s 
manufacturer or visit www.printimagematching.com to find out if PRINT Image Matching 
technology is included with your camera.

With PRINT Image Matching, the digital camera manufacturer can set specific printing 
options for each camera model. These options include:

■ Contrast, sharpness, and brightness

■ Gamma level, color space, color saturation, and noise reduction

■ Shadow point, highlight point, and color balance

The camera saves this information in each JPEG image file (and TIFF files from 
P.I.M. II-enabled cameras). Your printer—along with P.I.M.-enabled software, such as Epson 
Software™ Film Factory,™ or the P.I.M. II Plug-in for Adobe® Photoshop® —uses the 
information to ensure the most accurate image reproduction.

But don’t worry if your camera doesn’t include PRINT Image Matching technology—your 
Epson Stylus Photo R320 gives great photo printing results.

Note: For information on printing P.I.M. images from your computer, see your 
on-screen Reference Guide.

About Exif Print

The Exif (Exchangeable Image File) Print format includes information about your digital 
camera settings in JPEG files so your printer and application can use them to create accurate 
print settings. Most digital cameras store Exif Print information such as shutter speed, 
metering, flash, exposure settings, resolution, and lens use in the JPEG image file. Your 
printer—along with Epson Software Film Factory or P.I.M. II Plug-in for Adobe 
Photoshop—uses the information to ensure the most accurate image reproduction.
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About Your Documentation

To set up your printer and install its software, see the Start Here sheet. For basic printing 
without a computer, see the Quick Reference card. This book contains system requirements, 
important safety information, your warranty, and instructions on:

■ Viewing your on-screen Reference Guide 

■ Printing all types of photos without a computer

■ Printing with Windows or on a Macintosh 

■ Printing on CDs and DVDs

■ Maintaining the printer

■ Solving basic problems

For more details about printing with, maintaining, or troubleshooting your printer, see your 
on-screen Reference Guide, as described below. 

Warnings, Cautions, Notes, and Tips

Please follow these guidelines throughout:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your printer.

Tips contain additional hints for better printing.

Viewing Your On-Screen Reference Guide

Your printer CD-ROM includes an on-screen Reference Guide. You need a browser—such as 
Microsoft® Internet Explorer 4.0 or later, Netscape Navigator® 3.0 or later, or Safari™ 1.0 or 
later—to view it. If you are using a different browser, the pages may not display correctly. 
(A browser is not included on the printer software CD-ROM.)

You can view the on-screen Reference Guide by doing one of the following: 

■ Windows: Double-click the ESPR320 Reference Guide icon on your desktop. You can 
also click Start > Programs (or All Programs in Windows XP) > Epson > ESPR320 
Reference Guide > Reference Guide. 

■ Macintosh: Double-click the ESPR320 Reference Guide icon on your desktop.
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When you first open the Reference Guide, you see this screen:

Click a topic on the left to expand the table of contents, then click on the topic you want
to view.

■ If there’s a right arrow , click it to view subtopics, then click a topic.

■ Click the down arrow to close a subtopic list.

Note: If you see an icon for a graphic when viewing your Reference Guide in 
Netscape Navigator, click the Reload button to load the graphic.

Click here to 
expand the 
table of 
contents

Closed list, 
click to 
expand

Click to go 
to a topic
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Loading Paper

Epson offers a wide variety of papers that let you customize your projects and achieve 
professional results. This chapter gives you guidelines on:

■ “Loading Paper in the Sheet Feeder” below

■ “Storing Your Photos” on page 12

Loading Paper in the Sheet Feeder 

1. Open the paper support and raise the extension.

2. Place your paper short edge first against the right edge of the feeder, under the tab, with 
the printable (whiter or glossier) side up. If you are loading multiple sheets, fan the stack 
of paper before loading it to prevent paper jams.

Note: Don’t load paper above the arrow mark inside the left edge guide. Some 
special papers can be loaded only one sheet at a time. See your on-screen 
Reference Guide for details. 

3. Slide the left edge guide against the paper. Make sure it is snug, but not so tight that the 
paper is bent. (For letter-size paper, you may not need to move the edge guide over.) 

4. Open the output tray and pull out the extension.
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You should also follow these guidelines: 

■ Always load the short edge first, even when you’re printing landscape-oriented pictures.

■ When using special papers, check the paper package for additional instructions. Some 
papers require using a support sheet included in the package.

Note: Always keep unused paper in the original package and store it flat to 
prevent curling.

For instructions on loading special papers and envelopes in the printer, see your 
on-screen Reference Guide.

Storing Your Photos

With proper care, photographs from your Epson Stylus Photo R320 will last for many years. 
The special Epson inks designed for your printer are formulated to achieve improved 
lightfastness when used with Epson papers for prints that are properly displayed or stored. 

As with traditional photos, proper care will minimize color changes and lengthen display life:

■ For display, Epson recommends that prints be framed under glass or a protective plastic 
sleeve to protect them from atmospheric contaminants like humidity, cigarette smoke, 
and high levels of ozone. 

■ As with all photographs, keep your prints away from high temperatures and humidity and 
out of direct sunlight. 

■ For proper storage, Epson recommends that you keep prints in a photo album or plastic 
photo storage box in acid-free, archival sleeves commonly available from most camera 
stores.

Be sure to follow any other storage and display instructions included in the paper package.
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Accessing Photos

Follow the instructions in these sections to access your photos:

■ “Inserting Memory Cards” below

■ “Connecting External Devices” on page 14

■ “Copying Photos to Your Computer” on page 17

Inserting Memory Cards

1. Press the P Power button to turn on your Stylus Photo R320.

2. Open the memory card door.

3. Insert the memory card into one of the three slots, as shown below.

Note: Insert just one card at a time. See your on-screen Reference Guide for 
supported photo file formats.

4. Push the card in carefully until it stops (it doesn’t go in all the way). When it is in, the 
card light comes on. 

5. Close the memory card door.

After a moment, the printer reads and counts the number of images on your card. When 
it’s done, your images are available for printing (see page 19). 

CompactFlash or 
Microdrive 

(left)

Memory Stick, 
SD (Secure Digital), or 

MMC (MultiMediaCard)
(middle)

SmartMedia or
xD Picture Card 

(right)
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Removing Memory Cards

Note: If your printer is connected to your computer, see page 18 for instructions 
on removing your memory card.

Make sure the card light is not flashing, then pull the card straight out of the slot.

Caution: Do not remove a card while the card light is flashing; you may lose 
photos on your card.

Connecting External Devices

If you have one of the following devices, you can connect it directly to your printer using a 
USB cable:

■ Digital camera with PictBridge™ or USB DP (USB Direct Print) support

■ USB thumb drives (see http://support.epson.com for a list of compatible drives)

■ USB CD/DVD burners and drives (see http://support.epson.com for a list of compatible 
drives)

■ 100 or 250MB Iomega Zip drive, AC or USB powered

■ Memory cards with a commercially available USB adapter (such as the MicroTech™ 
ZiO!™)

■ MO (Magneto-Optical) drives

Note: Epson cannot guarantee the compatibility of any cameras or drives. If 
you’re not sure about your camera or drive, you can try connecting it. If it’s not 
compatible, you’ll see a screen saying that the connected device cannot be used.

If you are using a Zip disk or a thumb drive, it must be formatted as a FAT16 disk. If you 
insert a Macintosh-formatted Zip disk or thumb drive, you see an error message saying that 
the inserted card cannot be used with the printer.

Tip: When you connect a CD drive, you can also print photos from Picture CDs 
that you get from your photo lab.

Card light
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When you connect a digital camera or storage device, the printer treats it like a memory card. 
Follow these steps to connect it:

1. Remove any memory cards from the printer.

If you leave a card in the printer, images will be read from the card instead of your camera 
or storage device.

2. Connect the USB cable from your camera or storage device to the EXT I/F USB port on 
the front of the printer. Some digital cameras require a special USB cable; if so, be sure to 
use the one that came with the camera.

3. Turn on the printer and your camera or storage device. 

After a moment, the printer reads and counts the number of images on your card. When 
it’s done, your images are available for printing (see page 19).

Note: If you’ve backed up your images on a Zip disk, CD, or another storage 
device (see page 16), they’re stored in folders (001, 002, etc.). Use the and  
buttons on the printer’s control panel to highlight the folder you want to open, 
then press OK to open it.
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Saving Your Photos to an External Device

If you don’t have a computer, you can save photos that are on your camera’s memory card to 
an external device that you connect directly to your printer. This lets you delete the images on 
your memory card and reuse it without losing your original photos. Follow the steps below to 
save your photos to a Zip disk, CD-R, DVD-R, or thumb drive:

Note: Epson cannot guarantee the compatibility of any cameras or drives. If 
you’re not sure about your camera or drive, you can try connecting it. If it’s not 
compatible, you’ll see a screen saying that the connected device cannot be used.

1. Make sure the printer is turned on and the memory card you want to back up is inserted 
in the printer.

2. If the printer is connected to your computer, unplug the USB cable that connects the 
printer to your computer (otherwise files on the memory card may be copied to your 
computer).

3. If necessary, make sure your drive is plugged in and turned on. Then connect a USB cable 
from your drive to the EXT. I/F USB port on the front of the printer (see page 14).

4. Press the Direct Save button on the printer.

5. Press OK. When you see the “Beginning backup” message, press OK again to start the 
backup procedure. You may have to follow additional instructions on the printer screen. 
All the photos on your card are copied to your external storage device. Depending on how 
many photos there are, this may take several minutes.

Caution: Once the backup starts, don’t press any buttons on the printer or 
interrupt the process, or you may loose photos on your card or drive. If you need 
to stop the backup, press the y Stop button.

To print images saved on your external storage device, follow the instructions on page 19.
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Copying Photos to Your Computer

If you’ve taken digital photos with your camera, you can insert the memory card into your 
printer’s memory card slot and copy the photos to your computer. You can access the contents 
of the card just like any drive on your computer. 

1. Make sure your computer and printer are connected and turned on.

2. Open the memory card door.

3. Insert the memory card into the appropriate slot on the printer, as shown on page 13.

4. In Windows XP, you see a screen like this: 
You can choose any supported programs or options to open, 
view, or print your photos.

In Windows 98, Me, or 2000, PhotoStarter opens and copies 
your pictures to the Photos folder on your desktop. If this is 
the first time you’ve inserted a memory card, you see this 
message instead. Follow the instructions on page 18 to 
configure PhotoStarter.

On a Macintosh with Mac® OS X or Mac OS® 9, a drive icon appears on your desktop. 
You can open the drive and copy your photos to your computer. If you have iPhotoTM and 
you have it set to open when a digital camera is connected, it will open when you insert a 
memory card. 

5. When you’re done copying photos, remove the card as described on page 18.

Caution: If you access the card from your computer and delete files from the 
card, add files to the card, or format the card, the card may not work correctly 
with your camera and the printer may not be able to read the files on the card. 
Always format cards and delete pictures using your camera, and do not copy files 
to the card from your computer.
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Configuring PhotoStarter

1. When you see the message on page 17, click 
Next. You see the PhotoStarter setup assistant:

2. Click Next again. The setup assistant asks you 
a series of questions about how you want 
PhotoStarter to work.

The default settings do the following 
whenever you insert a memory card:

■ PhotoStarter copies your pictures to the 
Photos folder on your desktop.

■ The pictures are stored in folders by date.

■ Film Factory opens automatically. 

Note: Film Factory lets you view, modify, and print photos from your computer 
quickly and easily. For more information, see the Film Factory Getting Started Guide.

3. Change any of the settings you want, then click Next. When you see the Confirmation 
window, click End.

You can go back and change settings at any time by opening PhotoStarter:

■ In Windows, click Start > Programs (or All Programs) > Film Factory > EPSON 
PhotoStarter. Open the Settings menu and choose Change Settings.

■ On a Macintosh, open the EPSON PhotoStarter (or EPSON PhotoStarter for X) 
folder, open EPSON PhotoStarter, and choose Change Settings from the Tools menu.

Removing a Memory Card

Once you’re finished copying photos from your memory card, follow the steps below to 
remove it. Be sure to remove any cards before unplugging the USB cable from your printer.

Caution: Do not eject a card while the card light is flashing or without performing 
the steps described below, or you may lose data on the card. Be sure all cards 
have been removed before unplugging the USB cable.

1. Depending on your operating system, you may need to do one of the following:

■ In Windows Me, 2000, or XP, click the  Unplug or Eject Hardware icon on the 
taskbar. In Windows XP, click Safely Remove USB Mass Storage Device. In 
Windows Me and 2000, click Stop USB Mass Storage Device.

■ On a Macintosh, drag the memory card icon from your desktop to the trash.

2. To remove a card, pull it straight out of the slot.
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Printing Without a Computer

Your Epson Stylus Photo R320 lets you print photos quickly and easily without a computer. 
Just load paper, insert your digital camera’s memory card, choose print settings from the 
control panel, and press the green x Print button.

Easy Photo Printing

Before you begin, make sure the printer is in Basic mode. If 
the printer is in Advanced mode, press the Basic/Advanced 
button to select Basic mode.

Before you can print, you need to load 4 × 6 inch Epson Premium Glossy Photo Paper 
(see page 11) and insert your camera’s memory card in the appropriate card slot (see page 13).

Note: You can only print 4 × 6 inch photos in Basic mode. To print larger photos, 
see page 21.

Selecting the Photos You Want to Print

The Select Photo option lets you choose which photos to print. The following example tells 
you how to select a single photo.

1. Press or to highlight Select Photo, then press OK.

2. Press or to highlight the photo number you want to print, then press OK.

3. Press the green x Print button to print your photo.

Note: To cancel printing, press the red y Stop button.

Tip: The default number of copies to print is one. If you would like to print more 
copies, see page 20.
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To select multiple photos in the Select Photo menu, use one of these settings:

■ Individual: Select several photos by number, and choose one or more copies of each—for 
example, photos 2, 9, and 17.

■ All: Print all the photos on your card.

■ Index: Print an index sheet showing thumbnail images and photo numbers for all the 
photos on your card.

■ Range: Choose a sequence of photos on your card—for example, photos 7 through 12.

Note: If your camera supports DPOF or PictBridge, you can use your camera to 
select the photos you want to print and the number of copies.

For more information on selecting photos, see your on-screen Reference Guide.

Setting the Number of Copies

You can print from 1 to 100 copies of your selected photos. Keep in mind that if you are 
printing all photos or a range of photos, the number of copies applies to every photo.

Note: If you selected your photos using the Individual setting, you already 
selected the number of copies when you selected each photo to print, so the 
Copies setting can’t be changed.

1. After selecting photos, press or to highlight Copies, then press OK.

2. Press or to select the number of copies you want to print for each photo (1 to 100), 
then press OK.

3. Now you are ready to print. Press the green x Print button to print your photos.

Note: If you need to cancel printing, press the red y Stop button.
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Custom Photo Printing

Before you begin, make sure the printer is in Advanced mode. 
If the printer is in Basic mode, press the Basic/Advanced 
button to select Advanced mode.

1. Press or to highlight Select Photo, then press OK.

2. Press or to highlight the photo number you want to print, then press OK.

To select multiple photos in the Select Photo menu, use one of these settings:

■ Individual: Select several photos by number, and choose one or more copies for 
each—for example, photos 2, 9, and 17.

■ All: Print all the photos on your card

■ Index: Print an index sheet showing thumbnail images and photo numbers for all the 
photos on your card

■ Range: Choose a sequence of photos on your card—for example, photos 7 through 
12.

Note: If your camera supports DPOF or PictBridge, you can use your camera to 
select the photos you want to print and the number of copies.

For more information on selecting photos, see your on-screen Reference Guide.

3. After selecting photos, press OK to enter the Copies menu.

4. Press or to select the number of copies you want to print for each photo (1 to 100), 
then press OK.

You can print from 1 to 100 copies of your selected photos. Keep in mind that if you are 
printing all photos or a range of photos, the number of copies applies to every photo.

Note: If you selected your photos using the Individual setting, you already 
selected the number of copies when you selected each photo to print, so the 
Copies setting can’t be changed.

5. After selecting the number of copies, press OK to enter the Paper Type menu.
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6. Select the setting that matches the type of paper you loaded, then press OK. Refer to the 
table below:

7. After selecting the paper type, press OK to enter the Paper Size menu.

8. Select the size of the paper you’ve loaded, then press OK.

9. After selecting the paper size, press OK to enter the Layout menu.

10. Select one of the following layout options, then press OK.

For this paper Select this Paper Type setting

Epson Premium Glossy Photo Paper Prem. Glossy

Epson Premium Semigloss Photo Paper
Epson Semigloss Scrapbook Photo Paper

Semigloss

Epson Premium Luster Photo Paper Prem. Luster

Epson Photo Paper
Epson Glossy Photo Paper

Glossy Photo

Epson Matte Paper Heavyweight
PremierArtTM Matte Scrapbook Photo Paper

Matte

Plain paper
Epson Photo Quality Ink Jet Paper
Epson Premium Bright White Paper

Plain

Epson ColorLife® Photo Paper ColorLife

Epson Glossy Photo Greeting Cards Greeting

Epson Iron-On Transfer Paper Iron-on

Prints one photo per sheet, borderless; fits the photo lengthwise on the paper.

Prints one photo per sheet with borders around the edges.

Prints a photo on the top half of the sheet.

Prints two photos per sheet.

Prints four photos per sheet.

Prints eight photos per sheet.
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Note: If you don’t see the entire image in your prints, check to make sure the Fit 
to Frame and Crop options are Off (see page 25). 

11. If you selected to print All, an Index, or a Range of photos, you can print multiple sheets 
of your selected layout. Highlight Copies, then press OK to enter the Copies menu.

12. Select the number of copies, from 1 to 100, then press OK.

Note: If you selected your photos using the Individual setting, or if you’re using 
DPOF or PictBridge, the number of copies is already determined (it’s displayed as 
Pages next to the Copies setting), so the Copies setting can’t be changed.

13. If you would like to make further changes before printing, see “Touching Up Your 
Photos” on page 24, “Cropping and Sizing Your Photos” on page 25, and “Adding Photo 
Information” on page 27.

14. Press the green x Print button to print your photos.

Note: If you need to cancel printing, press the red y Stop button.

Saving Print Settings

If there are settings you use often, you can create your own custom settings and recall them at 
any time by pressing the Custom button.

1. From the control panel, select any of the following settings you want to save:

Prints 20 photos per sheet; the photo number and date are also printed with each 
photo. (Good for printing larger-size index prints.)
Prints an index of your photos; up to 80 photos on each letter-size sheet of paper.

Prints a CD/DVD jewel case insert with one photo on one side of the insert.

Prints a CD/DVD jewel case insert with twenty-four photos; twelve on each side of 
the insert.

■ Automatic Correction ■ Paper Type ■ Paper Size

■ Filter ■ Brightness ■ Layout

■ Saturation ■ Quality ■ Sharpness

■ Contrast
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2. When you have finished selecting your settings, press and hold the Custom button until 
you see a message saying that your settings have been saved.

When you want to print, press the Custom button to recall your settings. Make sure the 
correct paper is loaded, then press the green x Print button to print your selected photos.

Tip: If you adjust any settings after pressing the Custom button, any changes 
you make affect only the current print job and are not saved with your custom 
settings.

Touching Up Your Photos

Your Epson Stylus Photo R320 lets you correct the color and improve the image quality of 
your photos without using a computer. Two basic types of adjustments are available:

■ Automatic adjustments (see below)

If your camera supports PRINT Image Matching or Exif Print, you can use the printer’s 
P.I.M. or Exif Print setting to automatically adjust your photos for the best results.

If your camera doesn’t support PRINT Image Matching or Exif Print, you can use 
PhotoEnhanceTM to make adjustments for the type of environment in which your photos 
were taken. 

■ Manual adjustments (see page 25)

If your photos are too light or too dark, you can adjust their brightness or control the 
saturation and sharpness.

If you want, you can make manual adjustments while P.I.M., Exif Print, or 
PhotoEnhance are turned on in order to fine-tune your automatic settings.

Note: These settings affect only your printed pictures. They do not change your 
original image files.

These settings are saved when you turn off the printer or choose a different set 
of photos, so remember to turn off the settings when you’re done. 
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Automatically Adjusting Your Photos

When you use the printer’s automatic image adjustments, the adjustments are applied to all 
your photos.

1. Press or  to highlight More Options, then press OK.

2. Highlight Automatic Correction, then press OK.

3. Select from these options, then press OK:

■ P.I.M.: Uses your camera’s PRINT Image Matching settings (this option is 
automatically selected when your pictures contain P.I.M. data).

■ Exif: Uses your camera’s Exif Print settings (this option is automatically selected when 
your pictures contain Exif Print data). 

■ PhotoEnhance: Adjusts the brightness, contrast, and saturation of your photos.

■ None: Select this if you don’t want to use P.I.M., Exif, or PhotoEnhance. 

Note: These settings are saved when you turn off the printer or choose a 
different set of photos, so remember to turn off the settings when you’re done. 

To make manual adjustments in addition to the automatic ones, follow the steps in the next 
section.

Manually Adjusting Your Photos

1. Press or  to highlight More Options, then press OK. 

2. Highlight Contrast, Brightness, Saturation, Sharpness, or Filter, then press OK. 

3. Adjust any settings as necessary, then press OK.

Note: These settings are saved when you turn off the printer or choose a 
different set of photos, so remember to turn off the settings when you’re done.

Cropping and Sizing Your Photos

Your Epson Stylus Photo R320 lets you decide how your photos fit on the page with two 
options: Crop and Fit to Frame. 

1. Press or  to highlight More Options, then press OK. 

2. To print only a portion of your image, highlight Crop, then press OK. You can choose 
from 18 preset cropping options. 
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The dimensions 1.2× and 1.5× indicate how much the printed part of your photo is 
zoomed. For example, if you select 1.5×, it zooms in to 1.5 times the original size. A 
higher zoom level crops more of the image out of the photo. 

When selecting crop settings, you see a yellow border around the cropped area (shown 
above in black) on the preview monitor. Use the border only as a rough guide, since it is 
not exact.

Note: The entire photo still appears on the preview monitor after choosing a crop 
setting and does not reflect what you will see in your print. 

3. Choose an option, then press OK. (Choose Off to turn off cropping.) 

Upper left Upper center Upper right

Center left Center Center right

Lower left Lower center Lower right

1.2×

1.5×

1.5×

1.5× 1.5×

1.5× 1.5×

1.5×1.5×1.5×

1.2× 1.2×

1.2×1.2×

1.2× 1.2×

1.2×

1.2×
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4. If your photo is too long or wide to fit inside the available space on your selected layout, 
part of the image will be automatically cropped. If you want to turn off automatic 
cropping (leaving white space at the edges of the photo), highlight Fit to Frame and press 
OK. Then select Off and press OK.

Note: These settings are saved when you turn off the printer or choose a 
different set of photos, so remember to turn off the settings when you’re done.

Adding Photo Information

You can print the date and time each photo was taken, as well as 
the camera settings, in the lower right corner of your photos. 

1. Press or  to highlight More Options, then press OK.

2. To print the date, highlight Date, then press OK. 

3. Highlight a month, date, and year formatting option, then press OK.

4. To print the time, highlight Time, then press OK. Highlight 12-hour system or 
24-hour system, and press OK.

5. To print your camera’s exposure time (shutter speed), F-stop (aperture), and ISO speed, 
highlight Photo Information, then press OK. Select On, then press OK to activate the 
setting. 

When Date, Time, or Photo Information is turned on, the information prints on all photos 
in any layouts for which they are allowed. 

Note: These settings are saved when you turn off the printer or choose a 
different set of photos, so remember to change the settings back to None or Off 
when you’re done. 

Fit to Frame turned on Fit to Frame turned off

Cropped area

2002.02.04 10:36
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Printing Special Layouts

Using special Epson paper, you can make greeting cards, jewel case inserts, and iron-on 
transfers. You can also print directly to CDs and DVDs without even turning on your 
computer.

You can buy the following Epson papers for your projects:

■ Epson Glossy Photo Greeting Cards (part number S041606)

■ Epson Iron-On Transfer Paper (part number S041153)

To order Epson paper, contact your dealer or call the Epson StoreSM at (800) 873-7766, or visit 
our web site at www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 
for dealer referral.

You can order ink jet-printable CDs and DVDs from your local retailer or from several 
websites, including www.epsonstore.com, www.pcmall.com, www.cdw.com, 
www.warehouse.com, www.zones.com, www.macconnection.com, and 
www.pcconnection.com. Make sure you purchase CDs and DVDs that have an ink 
jet-printable surface.

For more information on selecting special layouts, see the on-screen Reference Guide.

Resetting Default Settings

After you change your settings in Advanced mode, you may want to reset the printer’s settings 
(such as the layout, color effects, or crop settings) to the default settings before printing
other photos. 

1. Make sure the printer is in Advanced mode (see page 21).

2. Press or  to highlight More Options, then press OK.

3. Select Restore to Factory Setting, then press OK.

4. Select YES to restore the settings to their defaults, then press OK.

Note: Not all settings are returned to their defaults using the Restore to Factory 
Settings feature.
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Printing From Your Computer

When you print from your computer, you can edit and enhance photos, create custom CDs 
or DVDs with your text or photos, or create greeting cards and calendars, and then print them 
out. Before you start, make sure your printer software is installed as described on the Start 
Here sheet. 

Note: To print photos from your computer, you can use a program like Film 
Factory, which is included on the CD-ROM that came with your printer.

Follow the instructions in these sections to print your photos:

■ “Basic Printing in Windows” on page 30

■ “Basic Printing on a Macintosh” on page 32

■ “Selecting the Correct Paper Type” on page 37

■ “Printing Borderless Photos” on page 38

■ “Printing on CDs or DVDs” on page 41
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Basic Printing in Windows

1. From the File menu, click Print. You see a Print window like this one:

2. Make sure EPSON Stylus Photo R320 Series is selected.

3. Click the Preferences or Properties button. (If you see a Setup, Printer, or Options 
button, click it. Then click Preferences or Properties on the next screen.)

4. Select the following in the Printing Preferences or Properties window:

Select your printer name here

Click here to open 
your printer software

Select the type of document you’re printing

Select your 
paper Type

Select your 
paper Size

Select your 
document or 
image orientation
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5. Select a Quality Option:

■ Draft: For rough drafts with reduced print quality.

■ Text: For text-only documents with higher text quality.

■ Text & Image: For documents with text and images with higher quality.

■ Photo: For photos and graphics with good quality and speed.

■ Best Photo: For photos or graphics with high print quality.

Note: The Quality Option settings on this screen give you the best combination 
of quality and speed for most prints. For information on selecting the highest 
quality (Photo RPM) on selected papers, see your on-screen Reference Guide.

You can select page layout settings by clicking the Page Layout tab in the Printing 
Preferences or Properties window.

6. Select the paper Type and Size for the paper you’ve loaded. See “Selecting the Correct 
Paper Type” on page 37 for more information about paper types.

7. Select your document or image Orientation.

Tip: For more information about printer settings, click the ? or Help button.

8. Click OK to close the Printing Preferences or Properties window.

9. At the Print window, click OK or Print to start printing.

During printing, this window appears and shows the progress of your print job. You can use 
the buttons to cancel, pause, or resume printing. You can also see how much ink you have left.

Click to cancel printing

Click to pause or 
resume printing
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Selecting Default Settings

Your printer settings only apply to the program you’re currently using. If you want, you can 
change the Windows default printer settings for all your programs.

1. Right click the  printer icon in the lower right corner of your screen (taskbar).

2. Select Printer Settings. You see the window shown on page 30.

3. Select the default settings you want for all your applications, then click OK.

You can still change the printer settings in your program, if necessary.

Basic Printing on a Macintosh

Follow the steps for your OS in these sections:

■ “Printing in OS X” below

■ “Printing in OS 9” on page 35

Printing in OS X

If you’re printing from an OS X compatible application, follow the steps below to print a 
document. (If you’re using an application that’s compatible only with Macintosh Classic 
mode, follow the steps on page 35 instead.) 

1. From the File menu, select Page Setup. You see a screen like this: 

2. Select Stylus Photo R320 in the Format for pop-up menu.

3. Select the Paper Size for the paper you’ve loaded.

Note: To print without borders, see page 38. To print double-sided pages, refer to 
your on-screen Reference Guide (see page 9). 

Select Stylus Photo R320

Select your Paper Size

Select your document or 
image orientation



Basic Printing on a Macintosh 33

4. Select your document or image Orientation.

5. Click OK to close the Page Setup window.

6. From the File menu, select Print. You see a screen like this:

7. Open the Printer menu and select Stylus Photo R320. 

8. Select Print Settings from the pop-up menu.

9. Select the following Print Settings as necessary:

Note: The Quality setting on this screen gives you the best combination of quality 
and speed for most prints. For information on selecting the highest quality (Photo 
RPM) on selected papers, see your on-screen Reference Guide.

Tip: For more information about printer settings, click ?.

Select Stylus Photo R320

Select Print Settings

Select Quality or Speed 
(for faster printing)

Select your Media Type 
(see page 37)

Select Automatic mode

Select Color (for color 
documents and black and 
white photographs) or 
Black for black text 
documents
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10. You can also choose these options from the Print Settings pop-up menu:

■ Copies & Pages: For selecting the number of copies or a page range.

■ Layout: For selecting page layout options.

■ Color Management: For adjusting the color controls, changing the gamma setting, 
or turning off color adjustments by the printer software.

■ Summary: For viewing a list of all your selections.

11. Click Print.

12. To monitor the progress of your print job, click the Print Center icon when it 
appears in the dock. Then double-click your printer name (Stylus Photo R320). 

In OS X 10.3.x click the  Stylus Photo R320 icon when it appears in the dock.

You see a screen like this:

13. Monitor the progress of your print job or do one of the following:

■ Click the print job, then click Delete to delete the job.

■ Click the print job, then click Hold to pause printing.

■ Click a print job marked “Hold” and click Resume to resume printing.

■ If multiple print jobs are listed and you want one to print before the other(s), select 
the job and click the Status arrow to move it up.

14. When you’re finished, close Print Center.
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Printing in OS 9

1. From the File menu, select Page Setup. You see a screen like this:

2. Make sure SP R320 Series is selected. If not, you need to select your printer in the 
Chooser. See the Start Here sheet for instructions.

3. Select the Paper Size for the paper you loaded.

4. Select your document or image Orientation.

5. Click OK to close the Page Setup window.

Note: To print without borders, see page 38. To print double-sided pages, refer to 
your on-screen Reference Guide (see page 9). 

6. From the File menu, select Print. You see a screen like this:

Note: The Quality setting on this screen gives you the best combination of quality 
and speed for most prints. For information on selecting the highest quality (Photo 
RPM) on selected papers, see your on-screen Reference Guide.

Make sure you see 
SP R320 Series

Select your paper 
size

Select an Orientation 
setting

Select higher quality or faster printing

Select your 
Media Type 
(see page 37)

Select Automatic mode

Select Color (for 
color documents 
and black and 
white photographs) 
or Black for black 
text documents
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7. You can also do the following:

■ Click  to reduce or enlarge your image, print multi-page layouts, or add a 
watermark.

■ Click  to control background printing and schedule print jobs. 

■ Click  to change the Print button to Preview. You can then click it to preview 
your printout.

■ Click  to check your ink levels.

Tip: For more information about printer settings, click the ? button. 

8. Click Print to start printing. If you turned on background printing, you can open the 
EPSON MonitorIV window by selecting it in the Application menu in the upper-right 
corner of your screen. 

9. Monitor the progress of your print job or do one of the following:

■ Click the print job, then click  to delete the job.

■ Click the print job, then  click to pause printing.

■ Click a print job marked “Hold” and click  to resume printing.

■ Click  to check ink levels.

If you’re not using background printing and you need to cancel printing, hold down the 
J key and press the . (period) key. For more information on printing—for example, printing 
posters or adding a watermark—see your on-screen Reference Guide.
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Selecting the Correct Paper Type

When printing, always be sure to select the correct paper Type (Windows) or Media Type 
(Macintosh) setting. This tells the printer what kind of paper you’re using so it can adjust the 
ink coverage accordingly.

Here are the settings you should choose for your paper when printing from your computer:

Note: The availability of paper types varies by location. 

For this paper

Select this Paper (Media Type) 

setting

Plain paper sheets or envelopes

Epson Iron-On Transfer Paper

Plain Paper

Epson Premium Bright White Paper Bright White Paper

Epson Photo Quality Ink Jet Paper

Epson Photo Quality Ink Jet Cards

Epson Photo Quality Self Adhesive Sheets

Photo Quality Ink Jet Paper

Epson Matte Paper Heavyweight

Epson Double-Sided Matte Paper

PremierArt Matte Scrapbook Photo Paper for Epson

Matte Paper - Heavyweight

Epson Photo Paper Photo Paper

Epson Glossy Photo Paper

Epson Photo Quality Glossy Paper

Epson Glossy Photo Greeting Cards

Glossy Photo Paper

Epson Premium Glossy Photo Paper

Epson Photo Stickers®

Premium Glossy Photo Paper

Epson Premium Luster Photo Paper Premium Luster Photo Paper

Epson Premium Semigloss Photo Paper

Epson Semigloss Scrapbook Photo Paper

Premium Semigloss Photo Paper

Epson ColorLife Photo Paper ColorLife Photo Paper

Epson Ink Jet Transparencies Ink Jet Transparencies 
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Printing Borderless Photos

You can print your photos without margins, extending the image all the way to the edges of 
the page. Although borderless printing is a bit slower, you get beautiful snapshots or 
enlargements without trimming, on these papers and sizes.

Caution: If you use an unsupported paper size, ink may spray inside your printer 
and mar future printouts.

See these sections for instructions on selecting printer settings:

■ “Windows” on page 39

■ “Macintosh OS X” on page 40

■ “Macintosh OS 9” on page 41

Paper name Sizes

Paper Type (Windows) or

Media Type setting (Macintosh)

Epson Matte Paper 
Heavyweight

Letter (8.5 × 11 inches)
8 × 10 inches

Matte Paper - Heavyweight

Epson Photo Paper Letter (8.5 × 11 inches) Photo Paper

Epson Glossy Photo 
Paper

Letter (8.5 × 11 inches)
4 × 6 inches

Glossy Photo Paper

Epson Premium Glossy 
Photo Paper

Letter (8.5 × 11 inches)
4 × 6, 5 × 7, or 8 × 10 
inches

Premium Glossy Photo Paper

Epson Premium 
Semigloss Photo Paper

Letter (8.5 × 11 inches) Premium Semigloss Photo Paper

Epson Premium Luster 
Photo Paper

Letter (8.5 × 11 inches) Premium Luster Photo Paper
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Windows 

Follow these steps to print borderless photos:

1. Start your photo program and open your photo.

2. Open the File menu and click Print. Then click Preferences or Properties.

You see a screen like this:

3. Select Photo or Best Photo as the Quality Option setting.

4. Choose Sheet as the paper Source setting.

5. Select one of the following paper types:

■ Matte Paper Heavyweight

■ Photo Paper

■ Glossy Photo Paper

■ Premium Glossy Photo Paper

■ Premium Semigloss Photo Paper

■ Premium Luster Photo Paper

6. Click the Borderless checkbox. Read the message and click OK.

7. Select the paper Size for the paper you’ve loaded.

8. Select your document or image Orientation.

9. Click OK to close the Printing Preferences or Properties window.

10. Click OK or Print to start printing.

Select Photo or 
Best Photo

Select your 
paper Type

Select your 
paper Size

Select your 
document or 
image orientation

Click the Borderless 
checkbox

Select Sheet
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Macintosh OS X

1. From the File menu, select Page Setup. You see a screen like this:

2. Select Stylus Photo R320 in the Format for pop-up menu.

3. Choose the borderless Paper Size for the paper you’ve loaded. 

4. Click OK to close the Page Setup window.

5. From the File menu, select Print.

6. Select Stylus Photo R320 in the Printer pop-up menu.

7. Select one of the following media types:

■ Matte Paper Heavyweight

■ Photo Paper

■ Glossy Photo Paper

■ Premium Glossy Photo Paper

■ Premium Semigloss Photo Paper

■ Premium Luster Photo Paper

8. Select other print settings as necessary, then click Print to start printing.

Select Stylus Photo R320 

Choose a borderless 
Paper Size
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Macintosh OS 9

1. From the File menu, select Page Setup. You see a screen like this:

2. Select the Paper Size for the paper you’ve loaded, then click the Borderless check box.

3. Click OK to close the Page Setup window.

4. From the File menu, select Print.

5. Select one of the following media types:

■ Matte Paper Heavyweight

■ Photo Paper

■ Glossy Photo Paper

■ Premium Glossy Photo Paper

■ Premium Semigloss Photo Paper

■ Premium Luster Photo Paper

6. Select print settings as necessary, then click Print to start printing.

Printing on CDs or DVDs

Your printer includes a special tray that lets you print customized text, graphics, and photos 
directly on any ink jet-printable CD or DVD. The EPSON Print CD software makes it easy 
to import your own photos, add text, and modify your designs with a variety of special effects. 
You can print on both standard-size 12-cm CDs and 8-cm mini CDs.

Caution: Use only ink jet-printable CDs or DVDs for printing. Thermal-printable 
and regular CDs and DVDs should not be used with this printer.

Select Auto Sheet FeederChoose a Paper SizeClick the Borderless checkbox
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Follow the steps in the sections below to print on CDs and DVDs. For information on 
designing CDs and DVDs, see the on-screen help in EPSON Print CD.

Note: EPSON Print CD is not available for Macintosh OS 9.

■ “Cleaning the Roller” below

■ “Inserting a CD or DVD” below

■ “Printing Your Design” on page 45

■ “Adjusting the Print Position” on page 45

■ “Adjusting the Print Density” on page 48

Cleaning the Roller

Before you print on CDs or DVDs, it’s a good idea to clean the roller inside the printer. You 
can do this by feeding and ejecting several sheets of plain paper. 

1. Make sure the printer is turned on and letter-size plain paper is loaded in the sheet feeder.

2. Make sure the printer is in Advanced mode. If the printer 
is in Basic mode, press the Basic/Advanced button to 
select Advanced mode.

3. Press the button to highlight More Options, then press OK. 

4. Press or to select Paper Feed/Paper Eject and press OK. 

5. Press OK to feed paper into the printer. 

6. Make sure Paper Feed/Paper Eject is still highlighted, then press OK. 

7. Press OK again to eject the paper from the printer. 

8. Repeat steps 4 through 7 several times.

Inserting a CD or DVD

Make sure the data, music, or video is burned on your ink jet-printable CDs or DVDs before 
you print. Otherwise, dirt or scratches on the surface may cause errors when you burn the 
data. If you plan to print large numbers of CDs or DVDs, it’s a good idea to print a small 
sample, then wait a day and check the quality to make sure it is satisfactory. 

If you want to check the print position or color, see the instructions for “Adjusting the Print 
Position” on page 45 and “Adjusting the Print Density” on page 48.

Before you insert a CD or DVD, make sure the printer is turned on. Otherwise, the disc may 
not be positioned correctly. 
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Follow these steps to load CDs and DVDs into your printer:

Caution: If you don’t insert the tray correctly, you may damage the printer or tray.

1. Open the printer cover and push in the output tray extension.

2. Lower the CD/DVD tray guide. 

3. Place the CD or DVD on the CD tray with the white or printable side face-up. Make sure 
the disc lays flat on the tray.

To print on a small CD (8 cm), place the small CD ring on the tray first, then place the 
CD inside the ring. 

Open printer cover

Push in 
extension

Lower CD/DVD 
tray guide
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Caution: Make sure you always use the small CD ring when printing 8 cm CDs and 
that the CD and ring lay flat on the tray; otherwise the printer may be damaged. 

4. Insert the tray into the printer carefully, making sure it is level, not tilted up or down. 

Slide the tray under the tab and the two rollers. Push it in until the arrows on the tray and 
guide are aligned. Don’t push the tray in too far; line up the arrows exactly. 

5. Follow the instructions in “Printing Your Design” on page 45 to print your CD or DVD. 

Always use this ring 
with 8 cm CDs

Line up arrows

Keep tray level

Load tray under tab
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Printing Your Design

After you have created your design and loaded a CD or DVD, you’re ready to print.

Note: For information on designing CDs and DVDs, see the EPSON Print CD 
on-screen Help.

1. Open the File menu and select Print.

2. Make sure Stylus Photo R320 is selected, then click Print.

Note: After you print, handle the CD or DVD carefully. To allow the ink to dry fully, 
wait at least 24 hours before playing the disc or inserting it in a drive. Keep 
printed discs away from moisture and direct sunlight.

If you want to check the print position or color, see the instructions for “Adjusting the Print 
Position” below and “Adjusting the Print Density” on page 48.

Adjusting the Print Position

If your printed images and text are not centered or positioned the way you want, you may 
need to adjust the printing position. Use the blank cardboard position check disk included 
with your printer or an extra CD. You can also use these steps to check the position before you 
print on a CD or DVD.

1. Place the position check disk (or an extra CD) on the CD tray and insert it into the 
printer, as described on page 42.

2. Start EPSON Print CD.

3. Select Print from the File menu.

Macintosh

Windows
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4. Make sure Stylus Photo R320 is selected, then click Print Position Confirmation 
Pattern (Windows) or Print Position Check Pattern (Macintosh).

5. Click Print. The confirmation pattern is printed on the position check disk or CD.

6. Remove the position check disk or CD and measure the distance from the edge of the 
hole to the small cross marks (distances labeled A and B as shown). You’ll need a metric 
ruler with millimeters for these measurements.

Macintosh

Windows
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7. Open the File menu and select Adjust Print Position. You see a screen like this:

8. Make sure Enter Values (Windows) or Value Entry (Macintosh) is checked. Input the A 
distance in the Height (Top) or Top Space box. Enter the B distance in the Width 
(Right) or Right Space box.

9. Click OK to save the measurements.

Enter measurements here

MacintoshWindows

Enter measurements here
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Adjusting the Print Density

If ink smears on your printed CDs or DVDs, you may need to adjust the color saturation or 
ink density. Discs from different manufacturers may absorb ink differently, so you may need 
to adjust the density for each type of disc. Follow these instructions to print a color saturation 
check pattern and make adjustments as necessary.

1. Insert a test CD or DVD for printing, as described on page 42.

2. Start EPSON Print CD.

3. Select Print from the File menu.

4. Make sure Stylus Photo R320 is selected, then click Print Density Confirmation 
Pattern (Windows) or Print Density Check Pattern (Macintosh).

5. Click Print.

6. After the pattern is printed, examine the print and make the Print Color Correction 
(Windows) or Color Correction (Macintosh) setting lighter or darker as necessary.

You can print three density patterns on one disc. Each pattern is printed in a different 
location.

7. After the first pattern is printed, adjust the setting, then repeat steps 4 through 6, 
selecting Second or Second Time to print the second pattern. 

8. If you want to try a third Color Correction setting, you can repeat steps 4 through 6 again 
and select Third or Third Time.

9. Remove the CD or DVD and let it dry for at least 24 hours. Then check the saturation 
levels again.

You can also use the Brightness and Contrast settings in EPSON Print CD to adjust color 
saturation. See the EPSON Print CD on-screen help for instructions.
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Maintaining Your Printer

This chapter describes maintenance procedures to keep your printer working its best and 
preparation steps for moving your printer. Follow the instructions here for: 

■ “Cleaning the Print Head” on page 50

■ “Replacing an Ink Cartridge” on page 51

■ “Aligning the Print Head” on page 55

■ “Cleaning the Printer” on page 56

■ “Transporting the Printer” on page 57

Note: You can also maintain your printer from the Maintenance tab on your driver 
(Windows) or from the Epson Printer Utility (Macintosh). For details, read your 
on-screen Reference Guide (described on page 9).

The steps in this chapter must be performed with the printer 
in Advanced mode. If the printer is in Basic mode, press the 
Basic/Advanced button to choose Advanced.
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Cleaning the Print Head

If your printouts are unexpectedly light or faint, or dots or lines are missing from the image, 
you may need to clean the print head. This unclogs the nozzles so they can deliver ink 
properly. Print head cleaning uses ink, so clean it only if quality declines.

You can clean the print head either from the printer’s control panel or using your printer 
software. To clean it using the printer software, the printer must be connected directly to your 
computer (not over a network); see your on-screen Reference Guide for details.

Caution: When you don’t turn on your printer for a long time, the print quality can 
decline, so turn it on at least once a month to maintain good print quality.

Follow these steps to clean the print head from the printer’s control panel:

1. Make sure the printer is turned on but not printing, and the red b error light is off.

If the red b error light is flashing or on, you may need to replace an ink cartridge; see 
page 51 for details.

2. Press  to highlight More Options, then press OK.

3. Press or  to highlight Head Cleaning, then press OK.

4. To begin cleaning, press OK. The printer makes noise and you see a progress bar on the 
LCD screen. Cleaning takes about 30 seconds.

Caution: Do not turn off the printer or interrupt the cleaning process.

5. When cleaning is done, run a nozzle check to confirm the print head nozzles are clean.

Make sure letter-size plain paper is loaded in the printer, then press Stop. The nozzle 
check pattern prints. 

6. Examine the nozzle check pattern you printed. Each staggered horizontal and straight 
vertical line should be complete, with no gaps in the pattern, as shown below:

■ If your printout looks okay, you’re done. Press OK to finish.

■ If there are any gaps (as shown below), press Stop to clean the print head again. 
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If you don’t see any improvement after cleaning three or four times, check the solutions 
beginning on page 64. You can also turn the printer off and wait overnight—this allows 
any dried ink to soften—and then try cleaning the print head again. 

Replacing an Ink Cartridge

You can check the status of the ink cartridges by looking at the icons on the control panel. 
Press the  to highlight More Options.

The level of ink shown on the icons indicates the approximate amount of ink remaining. If an 
ink cartridge is low, the red b error light flashes. This is a good time to make sure you have a 
new cartridge.

If an ink cartridge is empty, the red b error light remains on and you see a message on the 
display telling you that the cartridge needs to be replaced.

Caution: You cannot print if any ink cartridge is empty. Leave the empty cartridge 
installed in the printer until you have obtained a replacement, or the ink remaining in 
the print head nozzles may dry out. To ensure good results, use genuine Epson ink 
cartridges and do not refill them. Other products may cause damage to your printer 
not covered by Epson’s warranty.

When an installed cartridge is more than six months old, you may need to replace it 
if printouts don’t look their best. If the quality doesn’t improve after cleaning and aligning the 
print head, you can replace the cartridge even if the b error light is off.

 Ink cartridge levels
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Use these Epson ink cartridges within six months of installing them and before the expiration 
date on the package:

When you need new ink cartridges, contact your dealer or call the Epson Store at 
(800) 873-7766, or visit www.epsonstore.com (U.S. sales only). In Canada, please call 
(800) 463-7766 for dealer referral. 

Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once you start the ink cartridge 
replacement procedure, you must complete all the steps in one session. 

1. Make sure the printer is turned on and not printing, then open the printer cover.

2. Do one of the following:

■ If the red b error light is on (cartridge is empty), press the b Maintenance button.

■ If the red b error light is flashing (cartridge is low), press the b Maintenance 
button. You see Ink Cartridge Replacement highlighted in the Advanced Settings 
menu. Press OK.

■ If the b error light is off, press or  to choose More Options, then press OK. 
Then press or  to select Ink Cartridge Replacement.

3. You see a message on the LCD screen telling you that ink cartridge replacement will 
begin. Press OK to continue. The print head moves to the replacement position.

Cartridge Part number

Black T0481

Cyan T0482

Magenta T0483

Yellow T0484

Light Cyan T0485

Light Magenta T0486
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4. Open the cartridge cover. 

5. Press in the tab on the back of the cartridge and lift the cartridge out of the printer. 
Dispose of it carefully.

Warning: Keep ink cartridges out of the reach of children and do not drink the ink.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets 
in your eyes, flush them thoroughly with water.

6. Unwrap the new ink cartridge.

Caution: Don’t touch the green circuit board or remove any labels. 

Don’t touch the 
green part
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7. Lower the cartridge into the holder, with the green circuit board facing the front. Then 
gently push the cartridge down until it clicks into place. 

8. If you need to replace another ink cartridge, repeat steps 5 through 7 before continuing 
with step 9.

9. Close the ink cartridge cover.

10. Press OK and close the printer cover. 

The printer begins charging the ink delivery system. 

11. When you see a message that charging is complete (after about a minute), press OK.
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Aligning the Print Head

If your printouts contain misaligned vertical lines or horizontal banding, you may need to 
align the print head. 

You can align the print head either from the printer’s control panel or using your printer 
software. To align the print head from the printer software, the printer must be connected 
directly to your computer (not over a network); see your on-screen Reference Guide for details.

Note: For the best results, load letter-size Epson Photo Quality Ink Jet Paper in 
the printer whenever you check the print head alignment.

Follow these steps to align the print head using the control panel:

1. Make sure the printer is turned on but not printing, and letter-size paper is loaded.

2. Press  to highlight More Options, then press OK.

3. Press or  to highlight Print Head Alignment, then press OK.

4. Press OK to print the alignment pattern. 

5. Once the pattern is done printing, examine the first row or set of lines (marked #1). Select 
the line (1-15) in which all the vertical dots are best aligned. You may need to use a 
magnifying glass.

6. Press or  to select the number of that line (1-15), then press OK. 

7. Repeat step 6 to select the best line for sets #2, #3, and #4.

8. When you’re finished, press OK. 
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Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year. Follow
these steps: 

1. Turn off the printer, unplug the power cord, and disconnect the printer cable.

2. Remove all paper, then use a soft brush to clean any dust or dirt from the sheet feeder.

3. Clean the exterior of the printer with a soft, damp cloth. 

4. Use a soft, dry cloth to clean the LCD screen and preview monitor. Do not use liquid or 
chemical cleaners on these parts.

5. If ink has spilled inside the printer, wipe it off only in the area shown below using a soft, 
damp cloth.

Caution: Be careful not to wipe away lubricating grease inside the printer. 

Don’t touch the gears inside the printer.

Never use a hard or abrasive brush, or alcohol or thinner for cleaning; they can 
damage the printer components and case.

Don’t get water on the printer components and don’t spray lubricants or oils 
inside the printer.

Don’t use any cleaning sheets included with special paper; they may jam inside 
the printer.

Clean here
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Transporting the Printer

If you move your printer some distance, you need to prepare it for transportation in its 
original box or one of a similar size. 

Caution: To avoid damage, always leave the ink cartridges installed when 
transporting the printer.

1. Turn on the printer, wait until the print head locks in the far right position, then turn off 
the printer.

2. Unplug the power cord from the electrical outlet. Then disconnect the printer cable from 
the printer.

3. Remove any memory cards from the printer and close the memory card cover. 

4. Remove any paper from the printer, push down the paper support extension, and close 
the paper support.

5. Open the printer cover. Secure the ink cartridge holder to the printer with tape as shown, 
then close the printer cover. 

6. Make sure the CD/DVD tray guide is closed, then push in the output tray extension and 
close the output tray. 

7. Repack the printer and its attachments in the original box using the protective materials 
that came with them. See your Start Here sheet.

Keep the printer level as you transport it. After transporting the printer, remove the tape 
securing the print head and test your printer. If you notice a decline in print quality, clean the 
print head (see page 50); if output is misaligned, align the print head (see page 55). 

Tape the ink cartridge 
holder to the printer case
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Problem Solving

See these sections to diagnose and solve printer problems: 

■ “Diagnosing Problems” below

■ “Setup or Software Installation Problems” on page 63

■ “Printer Problems” on page 64

■ “Print Quality Problems” on page 65

■ “Problems With Paper Feeding” on page 68

■ “CD/DVD Printing Problems” on page 68

■ “Miscellaneous Printout Problems” on page 69

■ “Uninstalling Printer Software” on page 70

■ “Where To Get Help” on page 73

Diagnosing Problems

Your Epson Stylus Photo R320 includes a number of ways to help you diagnose problems:

■ To identify the most common problems, check for messages on the control panel display 
and follow the instructions provided.

■ If you’re not sure whether the problem is coming from your printer or the computer, run 
a printer check as described on page 62. 

■ Check other solutions in other sections in this chapter. If none of the suggested solutions 
solve your problem, contact Epson as described on page 73. 
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Control Panel Messages

Message Solution

Ink out.
Black: T0481
Cyan: T0482
Magenta: T0483
Yellow: T0484
Light Cyan: T0485
Light Magenta: T0486

The genuine Epson ink cartridges listed above are 
recommended for replacement.

Replace the ink cartridges 
shown with new ones.

Paper load error. Load paper correctly and press 
Maintenance.

Load paper in the sheet feeder 
(see page 11) and press the 
( Maintenance button to turn 
the error light off. The printer 
resumes printing.

A paper jam has occurred. See printer manual to clear 
the jam.

Press the ( Maintenance 
button to eject the jammed 
paper.

Ink cartridges cannot be recognized.
Black: T0481
Cyan: T0482
Magenta: T0483
Yellow: T0484
Light Cyan: T0485
Light Magenta: T0486

The genuine Epson ink cartridges listed above are 
recommended for replacement.

Reinstall the cartridge shown 
(see page 51). 

Service required.

Parts inside your printer are at the end of their service 
life. See your printer’s documentation for details.

Contact your dealer or Epson 
(see page 73).

Multi-page feed error 
Multiple pages have been fed into the printer at once, or 
the wrong paper size has been fed into the printer. 
Remove and reload the paper, then press the 
maintenance button.

Remove and reload the paper 
(see page 11) then press the 
( Maintenance button.
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Close the CD/DVD guide. Close the CD/DVD guide, then 
press the ( Maintenance 
button.

If the CD/DVD tray is inserted, 
remove the CD/DVD tray, then 
close the CD/DVD guide.

The CD/DVD tray is not set correctly. Reload the tray, 
then press the maintenance button.

Reload the CD/DVD tray, then 
press the ( Maintenance 
button (see page 42).

The inserted card cannot be used with this printer. Use a compatible, formatted 
memory card (see page 13). 

Bluetooth Photo Print Adapter error. Disconnect the 
Adapter from the printer, then reconnect it.

Disconnect the adapter, then 
reconnect it to the printer.

System error. Simultaneously press and hold the Power 
and Stop button for 7 seconds to turn off the printer.

Turn the printer off, then after a 
few seconds, turn it on again. If 
the error is not cleared, contact 
your dealer.

Ink icon blinks The printer is low on ink. Obtain 
a replacement ink cartridge (see 
page 52).

Communicating with computer. Please wait. Start printing from the LCD 
panel after printing from the 
computer is completed.

The connected device cannot be used. Connect an external storage 
device that is compatible with 
the printer (see page 14).

Message Solution
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Running a Printer Check

You may need to run a printer check to see if a problem comes from the printer itself or some 
other source.

1. Make sure both the printer and computer are turned off. Then disconnect the printer 
cable from the printer.

2. Make sure letter-size or larger paper is loaded in the printer.

3. Turn on the printer.

4. Press the ( Maintenance button.

5. Press  to highlight More Options, then press OK. 

6. Press or  to highlight Nozzle Check, then press OK.

7. Press OK to print the nozzle check. 

8. The printer prints a page showing a nozzle check pattern. (If the pattern has gaps, you 
need to clean the print head; see page 50.)

■ If the check page printed, the problem probably lies in your memory card, software 
settings, interface cable, or computer, or your software may not be installed correctly.

■ If the check page did not print, you may have a problem with your printer. Try the 
suggestions in “Setup or Software Installation Problems” beginning on page 63. If 
nothing works, contact your dealer or Epson as described on page 73.

9. After examining the check page, remember to turn off the printer and reconnect its cable 
to your computer.
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Setup or Software Installation Problems

The printer makes noise after ink cartridge installation.

■ The first time you install ink cartridges, the printer must charge its print head for about 
two minutes. Wait until charging finishes before you turn off the printer, or it may charge 
improperly and use excess ink the next time you turn it on. 

■ Make sure the ink cartridge cover is closed completely and no packing material remains in 
the printer. Turn off the printer, wait a moment, then turn it back on to clear the error.

You’re having problems installing the printer software.

■ Carefully follow the installation instructions on the Start Here sheet. Do not connect your 
printer to the computer until you are instructed to connect it. Connect the printer cable 
securely to the printer and the computer. Also make sure your system meets the 
requirements shown on page 75.

■ Close your other programs, including any screen savers and virus protection software, and 
install again.

■ If your printer icon (SP R320 Series) doesn’t appear in the Macintosh Chooser, you may 
have too many items in the Chooser. Delete any unused items and check the Chooser 
again.

■ If you are using Macintosh OS X and you do not see the printer name in the Format for 
menu under Page Setup, you may need to set up your printer in the Print Center or 
Printer Setup Utility. See the Start Here sheet for instructions. 

■ With Windows 2000, if you see an error message or your software doesn’t install correctly, 
you may not have software installation privileges. Contact your System Administrator.

■ Make sure Windows 98, Me, 2000, or XP was preinstalled on your system. The USB 
Printer Device Driver may not install correctly if you’ve upgraded from Windows 95.

■ Make sure the USB Controller is working properly in Device Manager. See your 
Windows help system for details. If it’s not working, contact your computer 
manufacturer.

■ If you’re printing over a network, see your on-screen Reference Guide for instructions on 
configuring your printer for use on a network.
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Printer Problems

The printer is on, but nothing prints.

■ If you’re printing from your computer, make sure the USB cable is connected securely and 
that the cable meets the system requirements on page 75.

■ If you’re printing from your computer, run a printer check as described on page 62. If the 
check page prints, make sure your software is installed correctly. 

■ If you’re printing on a network, you need to set up your printer for network printing, as 
described in your on-screen Reference Guide.

The printer sounds as though it is printing, but nothing prints.

■ Make sure the print head nozzles are not clogged. To clean the print head, see page 50.

■ The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, stable 
surface that extends beyond the printer base in all directions.

Your printer makes noise when you turn it on or after it has been sitting for awhile.

Your printer is performing routine maintenance.

The preview monitor and control panel respond too slowly.

When you have multiple photos or large files on your memory card, it takes longer for the 
preview monitor to process them. This causes the monitor and control panel to respond more 
slowly. Try deleting any photos you don’t need before you remove the card from your camera.

Printing is too slow.

Make sure your system meets the requirements listed on page 75. If you’re printing a 
high-resolution image, you need more than the minimum requirements listed. You may also 
need to:

■ Clear space on your hard drive or run a defragmentation utility.

■ Close open programs that you’re not using.

■ Increase your system’s memory (RAM).

For the fastest printing, try these tips:

■ Choose Black ink if your document doesn’t include color (except for black-and-white 
photos).

■ Set the Quality/Speed slider to Speed.
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■ In the Advanced options, turn MicroWeave® off and/or turn High Speed on.

■ If your printer is connected to a hub, disconnect USB devices that you’re not using.

Note: Borderless printing takes longer than normal, especially near the edges of 
the paper. Printing without a computer is also a bit slower.

■ If you are printing a landscape photo without a computer, it takes longer for the printer to 
rotate and process the image.

Your memory card does not work correctly.

■ If you’re using different kinds of memory cards, make sure only one card is inserted at a 
time.

■ Make sure the card contains no more than 999 photos (or the last photos won’t display), 
and that the photos are in JPEG or Uncompressed Tiff format and taken with a 
DCF-compliant digital camera.

■ Make sure you follow the instructions on the Start Here sheet to install the software, 
including the card utilities: Card Monitor and PhotoStarter.

■ Check your PhotoStarter settings. See page 18 for instructions.

■ If you access the card from your computer and delete files, the card may not work 
correctly with your camera. Always delete pictures using your camera.

■ If you’re using Windows XP, you may need to install your Windows storage device driver. 

Print Quality Problems

You see banding (light lines).

■ The print head nozzles may need cleaning; see page 50 for instructions. 

■ Select a higher print quality and turn off High Speed mode. See page 30 (Windows) or 
page 32 (Macintosh).

■ If you’re printing without a computer, make sure the printer’s Paper Type setting matches 
the type of paper you’re using; see page 22 for guidelines.

■ If you’re printing from a computer, make sure the paper Type or Media Type setting 
matches the paper you loaded; see page 37 for guidelines.

■ Make sure you load paper with the printable side face up. The printable side is usually the 
whiter or brighter side of the paper. 
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■ The ink cartridges may need replacing. To replace an ink cartridge, see page 51.

■ Run the Print Head Alignment utility; see page 55 for instructions. 

Your printout is blurry or smeared.

■ Use Epson papers to ensure proper saturation and absorption of genuine Epson inks. 

■ Make sure you load paper with the printable side face up. The printable side is usually the 
whiter or brighter side of the paper. 

■ Make sure your paper isn’t damp or curled, or loaded face down (the printable side should 
be face up). If it’s damp or curled, reload a new stack of paper.

■ When printing on special paper, check the instructions in the paper package. You may 
need to use an included support sheet or load your paper one sheet at a time.

■ Make sure your paper meets the specifications listed in the on-screen Reference Guide. 

■ Run the Print Head Alignment utility; see page 55 for instructions.

■ Remove each sheet from the output tray after printing, especially when you’re printing on 
transparencies.

■ If the options above don’t work, try using the Thick paper and envelopes setting: 

Windows: From the Maintenance tab in the Printing Properties or Preferences window, 
click Printer and Option Information, then select Thick paper and envelopes. 

Mac OS X: From the Print window, choose Extension Settings in the pop-up menu, 
then select Thick paper and envelopes.

Mac OS 9: From the Advanced print window, select Thick paper and envelopes.

Make sure you disable the Thick paper and envelopes option before printing on other 
types of paper, or print quality may be reduced. 

Your printout is grainy.

■ Try using a higher quality paper.

■ Select a higher print quality setting. If you’re printing from Windows, see page 30. If 
you’re printing from a Macintosh, see page 32. 

■ Run the Print Head Alignment utility; see page 55 for instructions.

■ You may need to increase the image resolution or print it in a smaller size; see your 
software documentation.
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Your printout is faint or has gaps in the image.

■ The print head nozzles may need cleaning; see page 50 for instructions. 

■ The ink cartridges may be old or low on ink. To replace an ink cartridge, see page 51. 

■ If you’re printing without a computer, make sure the printer’s Paper Type setting matches 
the type of paper you’re using; see page 22 for guidelines.

■ If you’re printing from a computer, make sure the paper Type or Media Type setting 
matches the paper you loaded; see page 37 for guidelines.

■ Make sure your paper isn’t damaged, old, dirty, or loaded face down. If it is, reload a new 
stack of paper with the printable side up; it is usually whiter or shinier.

You see wrong or missing colors.

■ Make sure the Ink setting is set to Color for color images or black-and-white photos. Also 
make sure your software is set for color printing.

■ The print head nozzles may need cleaning; see page 50 for instructions.

■ The ink cartridges may be old or low on ink. To replace an ink cartridge, see page 51.

■ Try turning off PhotoEnhance. Also check if you’re using a special effect that alters image 
colors, like Sepia. 

■ Try changing the Gamma setting in the Advanced window; see your on-screen Reference 
Guide for information about accessing Advanced settings.

■ Your printed colors can never exactly match your on-screen colors. However, you can use 
a color management system to get as close as possible. You can also use your printer’s color 
management features. See your on-screen Reference Guide for more information.

■ Colors will change slightly after drying. Wait for 24 hours and check your print again to 
see if the colors look right. 

■ If you are printing without a computer, check your printer’s control panel settings to 
make sure the Filter setting is not set to Sepia or B&W and that the image adjustment 
settings are set to Standard (see the on-screen Reference Guide).
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Problems With Paper Feeding

Paper doesn’t eject fully or is wrinkled.

■ If the paper doesn’t eject fully, you may have set the wrong paper size. Press the 
b Maintenance button to eject the paper, then select the correct paper size.

■ If it’s wrinkled when it ejects, the paper may be damp or too thin.

Paper doesn’t feed correctly or jams in the printer.

■ Make sure the paper support extension is pulled up. 

■ If paper doesn’t feed, remove it from the sheet feeder, reload it against the right edge, then 
slide the left edge guide against the paper.

■ If multiple pages feed at once, remove the paper from the sheet feeder, fan the edges to 
separate the sheets, and carefully reload it.

■ If paper jams, press the b Maintenance button to clear the jam. If that doesn’t clear the 
paper jam, open the cover and remove any jammed paper, including small pieces that may 
have torn off. Reload the paper and press the b Maintenance button.

If your paper loads incorrectly or jams frequently:

■ Use new, smooth, high-quality paper, loaded printable side up. Don’t load paper above 
the arrow mark on the left edge guide.

■ Place the paper against the right edge and slide the left edge guide against it, but not
too tightly.

■ Store paper flat to prevent curling.

CD/DVD Printing Problems

Images and text are not centered on the CD/DVD.

Adjust the print position as described on page 45.

Ink smears on the CD/DVD or printing is too light.

■ Adjust the print density as described on page 48. 

■ Adjust the brightness or contrast (see the EPSON Print CD on-screen help for details).
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■ Make sure you’re using ink jet-printable CDs or DVDs.

■ Handle the disc carefully and allow the ink to dry for at least 24 hours before playing the 
disc or inserting it in a drive. 

Printed CDs or DVDs are smeared or dirty.

Clean the roller; see page 42.

The CD or DVD won’t feed into the printer.

Make sure you hold the CD/DVD tray level as you load it into the tray guide, not tilting it up 
or down. Don’t push in the tray too far, but line up the arrows exactly as described on page 43. 

Miscellaneous Printout Problems

The image is reversed.

Turn off the Flip Horizontal setting in the Page Layout (Windows) or Advanced (Macintosh) 
window or the mirror setting in your program. (If you’re printing on Epson Iron-On Transfer 
Paper, the image should be reversed.)

The printer prints blank pages.

■ Make sure your printer is selected, or is the active printer in the Print Center, Printer 
Setup Utility, or Macintosh Chooser.

■ The print head nozzles may need cleaning; see page 50 for instructions. 

The margins are incorrect.

■ Make sure the paper settings are correct for your paper size. 

■ Make sure the paper is positioned correctly in the feeder, all the way to the right. Slide the 
left edge guide against the paper. 

■ See your software documentation for instructions on choosing the correct margins for 
your paper size. The margins must be within the printable area of the page. See “Printer 
Specifications” in your on-screen Reference Guide.

■ If you are printing without a computer, make sure the Crop and Fit to Frame settings are 
set to Off; see page 25 for instructions. 
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Image size or position is incorrect.

■ Make sure paper and layout options are set correctly.

■ Your images may not match the width/height proportions (aspect ratio) of the paper size 
or layout you’re using. Images may be cropped to fit the paper and layout.

You see incorrect characters.

■ Make sure the USB cable is securely connected and meets the system requirements on 
page 75. Then try printing again.

■ Make sure your printer is selected in your software, or is set as the active printer in the 
Print Center, Printer Setup Utility, or Macintosh Chooser. 

■ If you’re using a USB hub, connect the printer directly to your computer instead.

The wrong photo is printed.

The photo numbering in the printer may not match the numbering in your camera. If you’re 
printing without a computer, first print an index to identify your photos by number.

Too many copies are printing.

Make sure that the Copies option in your printer software or program is not set for multiple 
copies.

Uninstalling Printer Software

You may need to uninstall and then reinstall your printer driver and utilities. For example, 
this might be necessary when you upgrade your operating system. You don’t need to uninstall 
Film Factory, the P.I.M. II Plug-in, or your on-screen Reference Guide. 

Note: Do not turn off or disconnect the printer while you are uninstalling the 
software.

Windows

1. Click Start > Settings > Control Panel (Windows XP: click Start > Control Panel). 

2. Double-click Add/Remove Programs. 

3. Click EPSON Printer Software in the program list and click the Add/Remove button 
(Change/Remove in Windows 2000 and XP).
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4. In the next window, make sure your EPSON Stylus Photo R320 icon is selected and 
click OK. Then follow the on-screen instructions. 

5. In Windows 98 or Me, click EPSON USB Printer Devices in the program list and click 
the Add/Remove button. When you see the prompt asking if you want to reboot, click 
No. 

6. Click EPSON PhotoStarter in the program list and click the Add/Remove button 
(Change/Remove in Windows 2000 and XP). Then follow the on-screen instructions. 

7. Click EPSON CardMonitor in the program list and click the Add/Remove button 
(Change/Remove in Windows 2000 and XP). Then follow the on-screen instructions. 

8. Restart your computer when you’re done. 

When you are ready to reinstall the printer software, follow the instructions for your operating 
system on the Start Here sheet. 

Note: Remember that you don’t need to reinstall your optional photo software or 
on-screen Reference Guide, and you won’t see the license agreement.

Macintosh OS X

1. Open your Applications folder.

2. Drag the EPSON CardMonitor and EPSON PhotoStarter for X folders to the trash. 

3. Open the Utilities folder (in the Applications folder). 

4. Double-click the Print Center or Printer Setup Utility icon.

5. Select Stylus Photo R320, then click Delete. 

6. Close Print Center or the Printer Setup Utility. 

When you are ready to reinstall the printer software, follow the correct instructions for your 
operating system on the Start Here sheet. 

Note: Remember that you don’t need to reinstall your optional photo software or 
on-screen Reference Guide, and you won’t see the license agreement.
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Macintosh OS 9

1. Close all applications.

2. Insert the printer software CD-ROM.

3. In the Epson window, scroll down and double-click the Drivers folder.

4. Double-click the English folder.

5. Double-click the OS 9 folder.

6. Double-click the Installer icon and click Continue.

7. In the Installer dialog box, select Uninstall from the pull-down menu and click the 
Uninstall button. Follow the on-screen instructions and click Quit when you’re done.

8. In the Drivers > English folder, double-click the PhotoStarter folder, double-click the 
OS 9 folder, then double-click the Installer icon. When you see the license agreement, 
click Accept.

9. Select Uninstall from the pull-down menu and click the Uninstall button. Follow the 
on-screen instructions and click Quit when you’re done.

10. In the Drivers > English folder, double-click the CardMonitor folder, double-click the 
OS 9 folder, then double-click the Installer icon. When you see the license agreement, 
click Accept.

11. Select Uninstall from the pull-down menu and click the Uninstall button. Follow the 
on-screen instructions and click Quit when you’re done.

12. Restart your Macintosh.

When you are ready to reinstall the printer software, follow the correct instructions for your 
operating system on the Start Here sheet. 

Note: Remember that you don’t need to reinstall your optional photo software or 
on-screen Reference Guide, and you won’t see the license agreement. 
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Where To Get Help

Epson provides technical assistance 24 hours a day through the electronic support services and 
automated telephone services listed below:

To speak to a technical support representative, dial:

■ U.S.: (562) 276-7282, 6 AM to 8 PM, Pacific Time, Monday through Friday and 7 AM to 
4 PM, Saturday. 

■ Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Toll or long distance charges may apply.

Before you call, please have the following information ready:

■ Product name (Epson Stylus Photo R320)

■ Product serial number (located on the back of the printer)

■ Proof of purchase (such as a store receipt) and date of purchase

■ Computer configuration

■ Description of the problem

You can purchase ink cartridges, paper, manuals, and accessories from the Epson Store at 
(800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please call 
(800) 463-7766 for dealer referral.

Service Access

World Wide Web From the Internet, you can reach Epson Support at 
http://support.epson.com. At this site, you can download drivers 
and other files, look at product documentation, access 
troubleshooting information, and receive technical advice through 
e-mail.

Automated 
Telephone Services

A variety of automated help services are available 24 hours a day, 
seven days a week. To use these services, you must have a touch 
tone telephone and call (800) 922-8911. Your Epson 
SoundAdviceSM Express code is 70585. Use this code to quickly 
select the Epson Stylus Photo R320 in SoundAdvice.
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Windows System Requirements

■ A Microsoft Windows compatible PC with a Pentium® or better processor, 300 MHz or faster

■ Windows 98SE, Windows Me, Windows 2000, or Windows XP

■ 256MB of RAM (512MB or more recommended)

■ 200MB or more available hard disk space recommended

■ VGA or better display adapter and monitor

■ CD-ROM or DVD drive for installing the printer software

■ Windows-compliant USB port and a shielded USB “AB” cable up to 6.5 feet (2 meters) long.

Caution: Using an improperly shielded USB cable—especially a cable more than 6.5 feet 
(2 meters) long—may cause the printer to malfunction.

Macintosh System Requirements

■ An Apple® iMac™ series, Power Macintosh® G3, G4, or G5, PowerBook,® iBook,™ or eMac™

■ Mac® OS 9.2, or OS X 10.2 through 10.3.x

■ 256MB of available RAM (512MB recommended)

■ 200MB or more available hard disk space recommended

■ VGA display or better

■ CD-ROM or DVD drive for installing the printer software

■ Built-in USB port and a shielded USB “AB” cable up to 6.5 feet (2 meters) long.

Caution: Using an improperly shielded USB cable—especially a cable more than 6.5 feet 
(2 meters) long—may cause the printer to malfunction.
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Important Safety Instructions

Before using your printer, read the following safety instructions to make sure you use the printer safely 
and effectively:

■ Be sure to follow all warnings and instructions marked on the printer.

■ Use only the type of power source indicated on the printer’s label.

■ Connect all equipment to properly grounded power outlets. Avoid using outlets on the same 
circuit as photocopiers or air control systems that regularly switch on and off. 

■ Place the printer near a wall outlet where the plug can be easily unplugged.

Placez l’imprimante près d’une prise de contacte où la fiche peut être débranchée facilement.

■ Do not let the power cord become damaged or frayed. 

■ If you use an extension cord with the printer, make sure the total ampere rating of the devices 
plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total 
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere 
rating.

■ Keep your printer and computer system away from potential sources of electromagnetic 
interference, such as loudspeakers or cordless telephone base units.

■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.

■ Leave enough room around the printer for sufficient ventilation.

■ Do not place the printer near a radiator or heating vent or in direct sunlight.

■ Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The 
printer will not operate properly if it is tilted or at an angle.

■ Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid 
on the printer.

■ Use a soft, dry cloth only to clean the display and preview monitor. Do not use liquid or chemical 
cleaners on these parts. 

■ Always turn the printer off using the P Power button. It may take a moment for the printer to 
shut off after you press the button. Don’t switch off the power strip or unplug the printer until the 
printer is off.

■ Do not block or cover the openings in the printer’s case or insert objects through the slots. 

■ Except as specifically explained in this manual, do not attempt to service the printer yourself. 

■ Do not remove a memory card or turn off the printer while the computer and card are 
communicating (when the light next to the card is flashing). Doing so can corrupt files on the 
memory card.
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■ If the liquid crystal solution from the display or the preview monitor gets on your hands, wash 
them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them 
immediately with water. If discomfort or vision problems remain after a thorough flushing, see a 
physician immediately. 

■ Unplug the printer and refer servicing to qualified service personnel under the following 
conditions:

If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been 
dropped or the case damaged; if the display or preview monitor are damaged; if the printer does 
not operate normally or exhibits a distinct change in performance. Adjust only those controls that 
are covered by the operating instructions.

Ink Cartridge Safety Instructions

■ Keep ink cartridges out of the reach of children and do not drink the ink. 

■ Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply 
port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them 
immediately with water.

■ Do not put your hand inside the printer or touch the cartridge during printing.

■ Do not move the print head by hand. You may damage the printer.

■ Install the ink cartridge immediately after you remove it from its package. Leaving the cartridge 
unpacked for a long time before use can result in reduced print quality.

■ Do not use an ink cartridge beyond the date printed on the package. For best results, use up the 
ink cartridges within six months of first installing them.

■ Store ink cartridges in a cool, dark place.

■ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room 
temperature for at least three hours before using it.

■ Do not shake an ink cartridge; this can cause leakage.

■ Do not dismantle the ink cartridges or try to refill them. This could damage the print head.

■ Do not touch the green IC chip on the side of the cartridge. This may affect normal operation and 
printing.

■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and 
store it in the same environment as the printer. Note that there is a valve in the ink supply port, 
making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that 
the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.

■ Before transporting the printer, make sure the print head is capped in the far right position and the 
ink cartridges are in place. Tape the ink cartridge holder to the printer case to make sure it remains 
in the proper position.
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ENERGY STAR Compliance

As an ENERGY STAR Partner, Epson has determined that this product 
meets the ENERGY STAR guidelines for energy efficiency. The EPA 
ENERGY STAR office equipment program is a voluntary partnership 
with the computer and office equipment industry to promote the 
introduction of energy-efficient personal computers, monitors, 
printers, fax machines, and copiers in an effort to reduce air pollution 
caused by power generation.

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 
cause harmful interference to radio or television reception. However, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause interference to radio 
and television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.

■ Increase the separation between the equipment and receiver.

■ Connect the equipment into an outlet on a circuit different from that to which the receiver is 
connected.

■ Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this equipment will 
invalidate the FCC Certification of this device and may cause interference levels which exceed the 
limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a 
shielded equipment interface cable with this device. If this equipment has more than one interface 
connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly 
approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or 
CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc. 

Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806-2469
Telephone: (562) 290-5254 

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 
15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative 
unit tested and found to be compliant with the standards. Records maintained continue to reflect the 
equipment being produced can be expected to be within the variation accepted, due to quantity 
production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson

Type of Product: Ink Jet Printer

Model: B281B
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Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. (“Epson”) warrants to the original retail purchaser that the 
Epson printer covered by this limited warranty statement, if purchased and operated only in the United 
States or Canada, conforms to the manufacturer’s specifications and will be free from defects in 
workmanship and materials for a period of one (1) year from the date of original purchase. Epson also 
warrants that the consumable ink cartridges enclosed with the printer will perform to the 
manufacturer’s specified usage, which usage may expire before the expiration of the limited warranty for 
the Epson printer. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective during the 
warranty period, please call the Epson Connection at (562) 276-7282 (U.S.) or (905) 709-2567 
(Canada) for warranty repair instructions and return authorization. An Epson service technician will 
provide telephone diagnostic service to determine whether the printer requires service. If service is 
needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If 
Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, 
freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. 
Possessions). Shipments to other locations will be made freight collect. You are responsible for securely 
packaging the defective unit and returning it to Epson within five (5) working days of receipt of the 
replacement. Epson requires a debit or a credit card number to secure the cost of the replacement 
printer in the event that you fail to return the defective one. If your printer is being repaired, Epson will 
direct you to send your printer to Epson or its authorized service center, where the printer will be fixed 
and sent back to you. You are responsible for packing the printer and for all costs to and from the 
Epson authorized service center. When warranty service involves the exchange of the printer or a part, 
the item replaced becomes Epson property. The replacement printer or part may be new or refurbished 
to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and quality. 
Epson’s liability for replacement of the covered printer will not exceed the original retail selling price of 
the covered printer. Exchange products and parts assume the remaining warranty period of your 
original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty does not apply to refurbished or reconditioned 
products. This warranty covers only normal use in the United States and Canada. This warranty is not 
transferable. This warranty does not cover any color change or fading of prints or reimbursement of 
materials or services required for reprinting. This warranty does not cover damage to the Epson product 
caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not 
cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the Epson 
product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not 
responsible for warranty service should the Epson label or logo or the rating label or serial number be 
removed or should the product fail to be properly maintained or fail to function properly as a result of 
misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as 
fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson 
products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be 
identified or reproduced, you will be held responsible for the costs incurred.
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THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR 
FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS 
AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED 
ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE BY 
ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS WRITTEN 
WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL BE LIABLE 
FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR 
INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF 
WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some 
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the 
above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and 
you may have other rights which vary from jurisdiction to jurisdiction. 

Epson America, Inc. ■ P.O. Box 93012 ■ Long Beach, CA 90809-3012
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Index

A
Accessories, 73
Adjusting photo quality, 24 to 25
Aligning print head, 55
Automatic mode, Macintosh, 33, 35

B
Background printing, 36
Banding, 65 to 66
Basic printing

Macintosh, 32 to 36
Windows, 30 to 31

Blank pages, 69
Blurry images, 66
Borderless printing, 38 to 41

C
Cable, printer, 75
Cancelling printing

Macintosh, 34, 36
Windows, 31
without a computer, 19, 20, 23

CardMonitor, 65, 71, 72
CDs

adjusting print density, 48
adjusting print position, 45 to 47
cleaning roller, 42
inserting in printer, 42 to 44
ordering, 28
printing on, 41 to 48
problems, 68 to 69

Characters, incorrect, 70
Checking printer, 62

Cleaning
print head, 50
printer, 56
roller, 42
sheets, 56

Color Management settings, Macintosh, 34
Color problems, 67
ColorLife Photo Paper, 22, 37
CompactFlash memory card, 13
Control panel

messages, 60 to 61
safety, 77

Controlling printing
Macintosh, 34, 36
Windows, 31

Copies, setting number of, 20, 21
Copying photos to computer, 17 to 18
Cropping, 25 to 27

D
Declaration of Conformity, 79
Diagnosing problems, 59 to 62
DVDs, see CDs

E
Edge-to-edge printing, 38 to 41
Electronic manual, 9 to 10
Energy Star, 78
Epson

accessories, 73
help, 73
ink, 52
papers, 12, 19, 22, 37, 38 to 41
Print CD, 41, 45 to 48
Store, 52, 73
warranty, 80 to 81

Error messages, 60 to 61
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Exif Print
description, 8
printing photos with, 24 to 25

External devices
connecting, 14 to 15
saving photos to, 16

F
Faint images, 67
FCC, 78
Flip Horizontal setting, 69
Full bleed printing, 38 to 41

G
Glossy papers, 19, 22, 37, 38, 39, 40, 41
Grainy prints, 66

H
Head Cleaning utility, 50 to 51
Help, Epson, 73
High Speed setting, 65

I
Incorrect

characters, 70
colors, 67
margins, 69

Ink cartridge
level of ink in, 31, 36, 51
ordering, 52
replacing, 52 to 54
safety instructions, 53, 77

Ink Jet Transparencies, 37
Ink level, checking

Macintosh, 36
Windows, 31
without computer, 51

Inserting CD/DVD, 42 to 44
Installation problems, 63
Inverted image, 69

J
Jams, paper, 68

L
Layout problems, 70
Layout settings

Macintosh, 34, 36
Windows, 31
without a computer, 22 to 23

LCD panel
messages, 60 to 61
safety, 77

Luster Photo Paper, 37, 38

M
Macintosh

automatic mode, 33, 35
background printing, 36
basic printing, 32 to 34
cancelling printing, 34, 36
system requirements, 75
uninstalling software, 71 to 72

Maintaining printer, 49 to 56
Marginless printing, 38 to 41
Margins, incorrect, 69
Media Type setting

list of, 37
Mac OS 9, 35
Mac OS X, 33

Memory cards
backing up, 16
CompactFlash, 13
inserting, 13
Memory Stick, 13
Microdrive, 13
MMC (MultiMediaCard), 13
problems, 65
removing, 14, 18
SD (Secure Digital), 13
SmartMedia, 13
xD Picture Card, 13

Memory Stick, 13
Microdrive, 13
MicroWeave setting, 65
Mirror images, 69
MMC, 13
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Monitoring ink level
Macintosh, 36
Windows, 31
without computer, 51

Moving printer, 57
MultiMediaCard, 13

N
Network printing, 63
Noise, printer, 64
Nozzle Check, 50, 62

O
Orientation setting

Macintosh, 33, 35
Windows, 30, 39

P
P.I.M., see PRINT Image Matching
Page Setup

Macintosh OS 8.6 to 9.x, 35
Macintosh OS X, 32

Paper
Epson, 12, 19, 22, 37, 38 to 41
feeding problems, 68
loading, 11 to 12
orientation, 11 to 12, 33, 35

Paper Size setting
Macintosh, 33, 35, 40, 41
Windows, 30, 39

Paper Source setting
Windows, 39

Paper Type setting, Windows, 30 to 31

Photographs
accessing, 13 to 18
adjusting quality, 24 to 25
backing up, 16
copying to computer, 17
cropping, 25 to 27
displaying and storing, 12
printing with computer, 29 to 41
printing without computer, 19 to 28
saving to computer, 17
saving to external device, 16
sizing, 25 to 27

PhotoStarter, 18, 65
Preview monitor, 7, 64
Previewing printout, 36
Print CD software, EPSON, 41, 45 to 48
Print dialog box, 30, 33, 35
Print head

aligning, 55
cleaning, 50

Print Head Alignment utility, 55
PRINT Image Matching

description, 8
printing photos with, 24 to 25

Print position, CD/DVD, 45 to 47
Print quality

problems, 65 to 67
settings, 31, 33, 35

Print window, 30, 33, 35
Printer

cable, 75
check, 62
cleaning, 56
maintaining, 49 to 56
noise, 64
problems, 59 to 70
transporting, 57

Printing with a computer
basic, 30 to 34
borderless, 38 to 41
CDs and DVDs, 41 to 48
controlling, 31, 34, 36
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Printing without a computer
adjusting photo quality, 24 to 25
cropping, 25 to 27
PRINT Image Matching, 24 to 25
touching up photos, 24 to 25

Printing, slow, 64
Problems

CD/DVD, 68 to 69
diagnosing, 59 to 62
error messages, 60 to 61
ink, 60 to 61
installing software, 63
memory card, 65
miscellaneous, 69 to 70
paper feeding, 68
PhotoStarter, 65
preview monitor, 64
print quality, 65 to 67
printer, 59 to 70
setup, 63

Q
Quality problems, 65 to 67
Quality Type setting, 31
Quality/Speed setting, 33, 35

R
Reference Guide, 9 to 10
Resolution Performance Management (RPM), 

7, 31, 33, 35
Roller, cleaning, 42

S
Safety instructions, 76 to 77
SD card, 13
Secure Digital card, 13
Self adhesive sheets, 37
Sizing photos, 25 to 27
Slow printing, 64
SmartMedia card, 13
Smeared printout, 68

Software
EPSON Print CD, 41, 45 to 48
problems, solving, 63
uninstalling, 70 to 72

Storing photos, 12
System requirements, 75

T
Touching up photos, 24 to 25
Transferring photos to computer, 17 to 18
Transparencies, 37
Transporting printer, 57
Troubleshooting, 59 to 73
Type setting, Windows, 30 to 31

U
Uninstalling software, 70 to 72
USB, 64, 71, 75
Utilities

Head Cleaning, 50 to 51
Nozzle Check, 50 to 51
Print Head Alignment, 55

W
Warranty, 80 to 81
Windows

basic printing, 30 to 31
cancelling printing, 31
system requirements, 75
uninstalling software, 70

X
xD Picture Card, 13







How To Order Epson Ink and Paper
To order Epson ink cartridges and paper, contact your dealer or call the Epson Store at (800) 873-7766, 
or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

Epson Ink Cartridges

Black: T048120
Cyan: T048220
Light Cyan: T048520
Magenta: T048320
Light Magenta: T048620
Yellow: T048420

Epson Papers

Paper name Size Part number

Epson Premium Bright White Paper Letter (8.5 x 11 inches) S041586

Epson Photo Quality Ink Jet Paper Letter (8.5 x 11 inches) S041062

A4 (8.3 x 11.7 inches) S041061

Legal (8.5 x 14 inches) S041067

Epson Photo Quality Ink Jet Cards A6 (4.1 x 5.8 inches) S041054

Epson Photo Paper Panoramic (8.3 x 23 inches) S041145

Epson Glossy Photo Paper Borderless 4 x 6 inches, non-perforated S041458

4 x 6 inches, perforated edges S041134/S041671

Letter (8.5 x 11 inches) S041141/S041649/
S041272/S041271

Epson ColorLife Photo Paper Letter (8.5 x 11 inches) S041500

Epson Matte Paper Heavyweight Borderless 8 x 10 inches S041467

Letter (8.5 x 11 inches) S041257

Epson Double-Sided Matte Paper Letter (8.5 x 11 inches) S041568

Epson Premium Glossy Photo Paper Letter (8.5 x 11 inches) S041286/S041667

Borderless 4 x 6 inches S041727

Borderless 5 x 7 inches S041464

Borderless 8 x 10 inches S041465

Epson Premium Semigloss Photo Paper Letter (8.5 x 11 inches) S041331

Epson Premium Luster Photo Paper Letter (8.5 x 11 inches) S041405

Epson Photo Quality Self Adhesive Sheets A4 (8.3 x 11.7 inches) S041106

Epson Ink Jet Transparencies Letter (8.5 x 11 inches) S041064

Epson Iron-On Transfer Paper Letter (8.5 x 11 inches) S041153

Epson Glossy Photo Greeting Card Kit Letter (8.5 x 11 inches), perforated edges S041606

Epson Photo Stickers Kit (CD-ROM/paper) A6 (4.1 x 5.8 inches) S041144-KIT

Epson Photo Stickers (refill) A6 (4.1 x 5.8 inches) S041144 

Epson Semigloss Scrapbook Photo Paper Letter (8.5 x 11 inches) SCR1001

PremierArt Matte Scrapbook Photo Paper Letter (8.5 x 11 inches) SCR1002
for Epson

The availability of paper types varies by location.

Epson Ink Jet Papers
Use Epson paper and inks to get the same photo quality results that have earned Epson’s printers all of their
awards! Epson papers are specially coated to work with genuine Epson inks. Here are details about just a
few of Epson’s papers:

Premium Glossy Photo Paper
Water-resistant, photographic-weight paper with a high gloss finish.
Perfect for all photographic applications and available in a variety
of sizes. Framing is recommended for this paper type.

Photo Paper and Glossy Photo Paper
Photo quality, heavyweight glossy paper available in a variety of sizes,
including letter, 4 x 6, and panoramic. Perfect for color photo keepsakes 
of snapshots, reprints, and enlargements.

Matte Paper Heavyweight
Heavyweight, bright white, ultra-smooth coated paper with a matte finish. 
Perfect for photographs, signs, and crafts.

For more information on other Epson products and fun project ideas, 
look for the Epson Print LabSM Series at www.printlabseries.com.

See the inside back cover for a list of Epson papers and ink cartridges, and ordering information.



How To Order Epson Ink and Paper
To order Epson ink cartridges and paper, contact your dealer or call the Epson Store at (800) 873-7766, 
or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

Epson Ink Cartridges

Black: T048120
Cyan: T048220
Light Cyan: T048520
Magenta: T048320
Light Magenta: T048620
Yellow: T048420

Epson Papers

Paper name Size Part number

Epson Premium Bright White Paper Letter (8.5 x 11 inches) S041586

Epson Photo Quality Ink Jet Paper Letter (8.5 x 11 inches) S041062

A4 (8.3 x 11.7 inches) S041061

Legal (8.5 x 14 inches) S041067

Epson Photo Quality Ink Jet Cards A6 (4.1 x 5.8 inches) S041054

Epson Photo Paper Panoramic (8.3 x 23 inches) S041145

Epson Glossy Photo Paper Borderless 4 x 6 inches, non-perforated S041458

4 x 6 inches, perforated edges S041134/S041671

Letter (8.5 x 11 inches) S041141/S041649/
S041272/S041271

Epson ColorLife Photo Paper Letter (8.5 x 11 inches) S041500

Epson Matte Paper Heavyweight Borderless 8 x 10 inches S041467

Letter (8.5 x 11 inches) S041257

Epson Double-Sided Matte Paper Letter (8.5 x 11 inches) S041568

Epson Premium Glossy Photo Paper Letter (8.5 x 11 inches) S041286/S041667

Borderless 4 x 6 inches S041727

Borderless 5 x 7 inches S041464

Borderless 8 x 10 inches S041465

Epson Premium Semigloss Photo Paper Letter (8.5 x 11 inches) S041331

Epson Premium Luster Photo Paper Letter (8.5 x 11 inches) S041405

Epson Photo Quality Self Adhesive Sheets A4 (8.3 x 11.7 inches) S041106

Epson Ink Jet Transparencies Letter (8.5 x 11 inches) S041064

Epson Iron-On Transfer Paper Letter (8.5 x 11 inches) S041153

Epson Glossy Photo Greeting Card Kit Letter (8.5 x 11 inches), perforated edges S041606

Epson Photo Stickers Kit (CD-ROM/paper) A6 (4.1 x 5.8 inches) S041144-KIT

Epson Photo Stickers (refill) A6 (4.1 x 5.8 inches) S041144 

Epson Semigloss Scrapbook Photo Paper Letter (8.5 x 11 inches) SCR1001

PremierArt Matte Scrapbook Photo Paper Letter (8.5 x 11 inches) SCR1002
for Epson

The availability of paper types varies by location.

Epson Ink Jet Papers
Use Epson paper and inks to get the same photo quality results that have earned Epson’s printers all of their
awards! Epson papers are specially coated to work with genuine Epson inks. Here are details about just a
few of Epson’s papers:

Premium Glossy Photo Paper
Water-resistant, photographic-weight paper with a high gloss finish.
Perfect for all photographic applications and available in a variety
of sizes. Framing is recommended for this paper type.

Photo Paper and Glossy Photo Paper
Photo quality, heavyweight glossy paper available in a variety of sizes,
including letter, 4 x 6, and panoramic. Perfect for color photo keepsakes 
of snapshots, reprints, and enlargements.

Matte Paper Heavyweight
Heavyweight, bright white, ultra-smooth coated paper with a matte finish. 
Perfect for photographs, signs, and crafts.

For more information on other Epson products and fun project ideas, 
look for the Epson Print LabSM Series at www.printlabseries.com.

See the inside back cover for a list of Epson papers and ink cartridges, and ordering information.


	Front Matter
	Copyright Notice
	A Note Concerning the Responsible Use of Copyrighted Materials
	Trademarks

	Contents
	Welcome!
	About PRINT Image Matching
	About Exif Print
	About Your Documentation
	Warnings, Cautions, Notes, and Tips
	Viewing Your On-Screen Reference Guide


	Loading Paper
	Loading Paper in the Sheet Feeder
	Storing Your Photos

	Accessing Photos
	Inserting Memory Cards
	Removing Memory Cards

	Connecting External Devices
	Saving Your Photos to an External Device

	Copying Photos to Your Computer
	Configuring PhotoStarter
	Removing a Memory Card


	Printing Without a Computer
	Easy Photo Printing
	Selecting the Photos You Want to Print
	Setting the Number of Copies

	Custom Photo Printing
	Saving Print Settings
	Touching Up Your Photos
	Automatically Adjusting Your Photos
	Manually Adjusting Your Photos

	Cropping and Sizing Your Photos
	Adding Photo Information
	Printing Special Layouts
	Resetting Default Settings

	Printing From Your Computer
	Basic Printing in Windows
	Selecting Default Settings

	Basic Printing on a Macintosh
	Printing in OS X
	Printing in OS 9

	Selecting the Correct Paper Type
	Printing Borderless Photos
	Windows
	Macintosh OS X
	Macintosh OS 9

	Printing on CDs or DVDs
	Cleaning the Roller
	Inserting a CD or DVD
	Printing Your Design
	Adjusting the Print Position
	Adjusting the Print Density


	Maintaining Your Printer
	Cleaning the Print Head
	Replacing an Ink Cartridge
	Removing and Installing Ink Cartridges

	Aligning the Print Head
	Cleaning the Printer
	Transporting the Printer

	Problem Solving
	Diagnosing Problems
	Control Panel Messages
	Running a Printer Check

	Setup or Software Installation Problems
	Printer Problems
	Print Quality Problems
	Problems With Paper Feeding
	CD/DVD Printing Problems
	Miscellaneous Printout Problems
	Uninstalling Printer Software
	Windows
	Macintosh OS X
	Macintosh OS 9

	Where To Get Help

	Notices
	Windows System Requirements
	Macintosh System Requirements
	Important Safety Instructions
	Ink Cartridge Safety Instructions

	Energy Star Compliance
	FCC Compliance Statement
	Declaration of Conformity
	Epson America, Inc. Limited Warranty

	Index
	Epson Ink Jet Papers
	How To Order Epson Ink and Paper

